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I 

SAŽETAK 

U diplomskom je radu cilj opisati postupak izrade digitalne dokumentacije gibljive grede 

transportnih kolica te faze modeliranja modela. 

U teorijskom su dijelu diplomskog rada opisani razvoj i varijante gibljive grede te uloga gibljive 

grede na transportnim kolicima. 

U praktičnom je dijelu izrađena digitalna dokumentacija u programu Siemens PLM NX . Kod 

modeliranja dijelova gibljive grede, korišteni su osnovni postupci i alati koji su detaljno objašnjeni 

u poglavlju. 

 

Ključne riječi: gibljiva greda, digitalna dokumentacija, Siemens  PLM  NX.  

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

II 

SADRŽAJ 

SAŽETAK ..................................................................................................................... I 

SADRŽAJ .................................................................................................................... II 

POPIS SLIKA ........................................................................................................... III 

POPIS TABLICA ...................................................................................................... VI 

PREGLED VELIČINA, OZNAKA I JEDINICA ................................................ VII 

1. UVOD .................................................................................................................... 1 

2. GIBLJIVA GREDA NA TRANSPORTNIM KOLICIMA KOMBAJNA ..... 2 

2.1. TRANSPORTNA KOLICA KOMBAJNA .................................................................................... 2 

2.2. TANDEM GIBLJIVA GREDA ................................................................................................... 5 

2.2.1 Razvoj gibljive grede .......................................................................................... 5 

2.2.2 Transportna kolica sa gibljivom gredom ......................................................... 10 

3. ODABIR RAČUNALNOG ALATA - SIEMENS PLM NX ........................... 13 

3.1. NX CAD ............................................................................................................................ 13 

3.2. NX CAM............................................................................................................................ 14 

3.3. NX CAE ............................................................................................................................. 16 

3.4. NX KORISNICI .................................................................................................................... 17 

4. POSTUPAK IZRADE DIGITALNE DOKUMENTACIJE........................... 19 

4.1. KONSTRUIRANJE PROIZVODA ........................................................................................... 19 

4.2. UPRAVLJENJE DOKUMENTIMA .......................................................................................... 21 

5. IZRADA DIGITALNE DOKUMENTACIJE GIBLJIVE GREDE .............. 23 

5.1. RADNO OKRUŽENJE PROGRAMA ....................................................................................... 24 

5.2. OBLIKOVANJE 3D OBJEKTA .............................................................................................. 26 

5.2.1 Oblikovanje urezanog navoja sa stožastim upustom ....................................... 35 

5.2.2 Oblikovanje elementa alatom Revolve ............................................................. 38 

5.2.3 Oblikovanje  modela od tankog lima- Sheet Metal .......................................... 41 

5.2.4 Modeliranje sklopova gibljive grede................................................................ 45 

5.3. IZRADA TEHNIČKIH CRTEŽA ............................................................................................. 51 

6. ANALIZA I DISKUSIJA POSTUPKA ............................................................ 62 

7. ZAKLJUČAK ..................................................................................................... 63 

8. LITERATURA ................................................................................................... 64 

PRILOZI .................................................................................................................... 65 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

III 

POPIS SLIKA 

 

Slika 2.1 Kombajn sa žetvenim uređajem na kolicima......................................................................... 2 

Slika 2.2 Sadašnja kolica Same Deutz Fahr ........................................................................................ 3 

Slika 2.3 Širina i masa žetvenog uređaja ............................................................................................. 4 

Slika 2.4 Nova kolica sa tandem gibljivom gredom ............................................................................. 4 

Slika 2.5 Magnus Hendrickson (desno) [1] ......................................................................................... 5 

Slika 2.6 Tandem gibljiva greda [1] .................................................................................................... 5 

Slika 2.7 Gibljive grede u sklopu s osovinama .................................................................................... 6 

Slika 2.8 Shema gibljive grede ............................................................................................................. 7 

Slika 2.9 Gibljiva  greda s lisnatim oprugama [2] .............................................................................. 7 

Slika 2.10 Air-link gibljiva greda sa suspenzijom zračnih jastuka ...................................................... 8 

Slika 2.11 Greder s pogonskim tandem osovinama [3] ....................................................................... 9 

Slika 2.12 Konfiguracija pogonske gibajuće grede [3] ....................................................................... 9 

Slika 2.13 Tandem kolica sa gibljivom gredom ................................................................................. 10 

Slika 2.14 Sastavni dijelovi desne gibljive grede za transportna kolica ............................................ 12 

Slika 3.1 Slijed razvoja proizvoda pomoću alata NX CAM ............................................................... 14 

Slika 3.2 Mogućnosti Siemens PLM NX CAM modula ...................................................................... 15 

Slika 3.3 Simulacija strujanja -Flow NX CAE ................................................................................... 16 

Slika 3.5 Slika aviona Sukhoi Su-30................................................................................................... 17 

Slika 3.6 Red Bull Racing Formula 1 ................................................................................................ 18 

Slika 4.1 Grafičko sučelje Siemens NX .............................................................................................. 20 

Slika 4.2 Upravljanje sklopova –Assembly Navigator ....................................................................... 22 

Slika 5.1 Prikaz sastavnih dijelova sklopa Gibljiva greda ................................................................ 23 

Slika 5.2 Osnovno sučelje programa Siemens NX ............................................................................. 24 

Slika 5.3 Prozor za kreiranje nove datoteke -New ............................................................................. 25 

Slika 5.4 Odabir radne ravnine.......................................................................................................... 27 

Slika 5.5 Skiciranje i postavljanje ograničenja ................................................................................. 27 

Slika 5.6 Tablica za uređenje parametara -Expressions ................................................................... 28 

Slika 5.7 Prozor sa geometrijskim ograničenjeima ........................................................................... 29 

Slika 5.8 Ekstrudiranje -Extrude ........................................................................................................ 29 

Slika 5.9 Ekstrudirani početni model ................................................................................................. 30 

Slika 5.10 Brzi izbor radne površine .................................................................................................. 30 

Slika 5.11 Primjer skiciranja na modelu ........................................................................................... 31 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

IV 

Slika 5.12 Brzi izbor radne površine .................................................................................................. 32 

Slika 5.13 Primjer skiciranja na modelu ........................................................................................... 32 

Slika 5.14 Podloška Ø50x70x4 .......................................................................................................... 33 

Slika 5.15 Prsten Ø50x70x20 ............................................................................................................. 33 

Slika 5.16 Osovina ............................................................................................................................. 34 

Slika 5.17 Čahura u presjeku ............................................................................................................. 34 

Slika 5.18 Kuglični ležaj Ø18x80x40 ................................................................................................. 35 

Slika 5.19 Operacija urezivanja navoja ............................................................................................. 36 

Slika 5.20 Operacija izrade stožastog upusta .................................................................................... 37 

Slika 5.21 Rukavac sa urezanim navojem i stožastim upustom ......................................................... 37 

Slika 5.22 Rotiranje skice za 360° alatom Revolve ............................................................................ 38 

Slika 5.23 Rotiranje skice manje od 360° sa alatom Revolve ............................................................ 39 

Slika 5.24 Skiciranje pojačanja prirubnice na novoj površini i naredba Instnce Geometry ............. 40 

Slika 5.25 Konačni izgled glavčine sa presjekom .............................................................................. 40 

Slika 5.26 Sučelje Sheet Metal ........................................................................................................... 41 

Slika 5.27 Skiciranje osnovne ploče ................................................................................................... 42 

Slika 5.28 Izrada obodne stranice...................................................................................................... 43 

Slika 5.29 Dodatne obodne stranice na osnovnoj ploči ..................................................................... 43 

Slika 5.30 Sučelje za spajanje rubova obodnih stranica ................................................................... 44 

Slika 5.31 Razvijeni oblik oplate -Flat Pattern .................................................................................. 44 

Slika 5.32 Sučelje za modeliranje sklopova - Assembly ..................................................................... 45 

Slika 5.33 Prozor za umetanje komponente u sklop - Part Name ...................................................... 46 

Slika 5.34 Prozor za ograničavanje komponenti u sklopu - Assembly Constraints ........................... 49 

Slika 5.35 Dodavanje elemenata u sklop i geometrijska ograničenja ............................................... 50 

Slika 5.36 Primjer kutnog zavara na gibljivoj gredi .......................................................................... 50 

Slika 5.37 Gibljiva greda ................................................................................................................... 51 

Slika 5.38 Sučelje za izradu tehničkih crteža ..................................................................................... 52 

Slika 5.39 Bazni pogled i njegova pravokutna projekcija ................................................................. 53 

Slika 5.40 Naredbe za postavljanje kota - Inferred Dimension ......................................................... 54 

Slika 5.41 Tehnički crtež dijela Osovina ............................................................................................ 55 

Slika 5.42 Tehnički crtež dijela Čahura ............................................................................................. 55 

Slika 5.43 Tehnički crtež limene oplate gibljive grede ...................................................................... 56 

Slika 5.44 Tehnički crtež dijela Rukavac ........................................................................................... 56 

Slika 5.45 Tehnički crtež zavarenog pod-sklopa lijeve gibljive grede ............................................... 57 

Slika 5.46 Tehnički crtež dijela Graničnik ......................................................................................... 57 

Slika 5.47 Tehnički crtež pod-sklopa desne gibljive grede ................................................................ 58 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

V 

Slika 5.48 Tehnički crtež dijela Podloška .......................................................................................... 58 

Slika 5.49 Tehnički crtež dijela Prsten............................................................................................... 59 

Slika 5.50 Tehnički crtež dijela Ležaj Ø18x80x40 ............................................................................. 59 

Slika 5.51 Tehnički crtež dijela Glavčina .......................................................................................... 60 

Slika 5.52 Tehnički crtež vijčanog pod sklopa gibljive grede ............................................................ 60 

Slika 5.53 Gibljiva greda u realnom prikazu ..................................................................................... 61 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

VI 

POPIS TABLICA 

 

Tablica 3.1 Mogućnosti Siemens PLM NX CAM ............................................................................. 15 

Tablica 5.1 Tablica standardnih dimenzija vijka ............................................................................... 43 

Tablica 5.2 Tablica standardnih dimenzija vijka (nastavak) .............................................................. 44 

 

 

 

 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

VII 

PREGLED VELIČINA, OZNAKA I JEDINICA  

PLM   od engl. Product Lifecycle Management-cjeloživotno upravljanje proizvodom 

UGS   Unigraphics 

I-DEAS   od engl. Integrated Design and Engineering Analysis Software - integrirani 

softver za  konstruiranje i inženjersku analizu 

CAD   od engl. Computer Aided Design- računalom podržano oblikovanje 

CAM  od engl. Compute Aided Manufacturing- računalom podržana priprema za 

proizvodnju 

CAE   od engl. Computer Aided Engineering - računalom podržan inženjering 

FEM   od engl. Finite Element Method – metoda konačnih elemenata 

2D   dvodimenzionalno 

3D   trodimenzionalno 

CNC   od engl. Computer Numerical Control–upravljanje računalom 

NC    od engl. Numerical Control – numeričko upravljanje 

SDRC   Structural Dynamics Research Corporation 

ISO  Međunarodna organizacija za normizaciju 

ASME   od engl. American Society of Mechanical Engineers -  Američko društvo inženjera   

strojarstva 

JEITA   od engl. Japan Electronic and Information Technology Industries Association –  

Udruga japanske industrije elektronike i informacijskih tehnologija 

UNI   od tal. Ente Nazionale Italiano di Unificazione (engl. Italian Organization for    

Standardization) – Talijanski organizacija za norme 

 

                     



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

1 

1. UVOD 

U radu je opisan postupak izrade digitalne dokumentacije gibljive grede transportnih kolica.  

Digitalnu sam dokumentaciju gibljive grede izradio osobno u tvornici kombajna Same Deutz Fhar. 

Za izradu dokumentacije, korišten jedan od modula programa Siemens PLM NX  za prostorno 

modeliranje. U programu je izrađen 3D model gibljive grede kao i tehnička dokumentacija. 

Gibljiva greda je podsklop novih transportnih kolica koja se priključuju na kombajn pri 

transportu žetvenog uređaja preko javnih prometnica. Tvornica Same Deutz Fahr, uz proizvodnju 

kombajna i žetvenih uređaja, proizvodi i kolica koja su jednoosovinskog karaktera te su kao takva 

zadržala svoj izgled preko 30 godina. Uz novu seriju kombajna,  razvijaju se nova kolica sa tandem 

gibljivom gredom. U AutoCAD-u su izrađeni tehnički crteži kolica sa gibljivom gredom koji su 

poslužili kao podloga za izradu modela i tehničkih crteža u sustavu Siemens PLM NX, za daljnje 

potrebe tvornice (prezentacije, analize i sl.). 

U drugom je poglavlju diplomskog rada opisana  gibljiva greda kroz povijesni razvoj,  njene 

izvedbene varijente i predstavljena je kao inovacija pri izradi novih transportnih kolica. 

U trećem je  poglavlju predstavljen izabrani Siemens PLM NX, program za izradu digitalne 

dokumentacije. Opisani su moduli koji su integrirani u program i njihove mogućnosti, a zatim su 

nabrojane uspješne tvrtke koje koriste sustav Siemens PLM NX. 

U četvrtom je poglavlju objašnjen općeniti postupak izrade digitalne dokumentacije. 

U petom su poglavlju objašnjeni postupci izrade modela i digitalne dokumentacije kroz 

dijelove koje čine podsklop gibljive grede. Opisani su: osnovni postupci izrade modela dijelova, 

postupci međusobnih geometrijskih ograničenja u sklopu, izrada modela zavarivačkog pod-sklopa i 

konačnog vijčanog pod-sklopa. 

U šestom je poglavlju izvršena analiza i diskusija postupaka izrade digitalne dokumentacije 

gibljive grede. 
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2. GIBLJIVA GREDA NA TRANSPORTNIM KOLICIMA 

KOMBAJNA 

U poglavlju će biti obrazložena potreba za razvojem novih transportnih kolica i međusobna 

povezanost transportnih kolica s gibljivom gredom. U nastavku je opisan povijesni razvoj, princip 

rada i varijante gibljive grede. Također, opisana je konstrukcija gibljive grede novih transportnih 

kolica tvrtke Same Deutz Fahr. 

Grupacija Same Deutz Fahr je 2005 godine preuzela nekadašnju tvornicu poljoprivrednih 

strojeva i uređaja "Đuro Đaković", koji su počeli sa montažom kombajna davne 1984 g. Same Deutz 

Fahr je modernizirao poslovanje, konsolidirao proizvodnju kombajna i uveo nove proizvode. 

Trenutno se proizvode kombajni serije 6000 (koji se dijele na pet i šest slamotresa), EKO i ROTO 

kombajn. Uz kombajne se proizvodi i dodatna oprema kao što su žetveni uređaji i pripadajuća 

transportna kolica za uređaj ( 

Slika 2.1). 

 

Slika 2.1 Kombajn sa žetvenim uređajem na kolicima 
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2.1. Transportna kolica kombajna 

Žetveni su uređaji inače dosta široki, tako da je kombajn s montiranim uređajem preširok za 

kretanje po javnim prometnicama. Potrebna su kolica da bi otkačeni uređaj transportirali preko 

javnih prometnica. 

Tvornica Same Deutz Fahr, nekada "Đuro Đaković", uz proizvodnju kombajna i žetvenih 

uređaja proizvodi i kolica koja su zadržala svoj izgled i konstrukciju otprije 30 godina i koja su 

nosila sve vrste žetvenih uređaja (od 3,6 do 7,2 m). Kolica se sastoje od postolja, nosećih sedla 

montiranih na postolje koja su oblikovana da stabiliziraju i nose uređaj pri transportu, krute osovine 

na kojima su montirani kotači, ruda, pomoćnog kotača i nosača za rasvjetu (Slika 2.2). 

 

 

 Slika 2.2 Sadašnja kolica Same Deutz Fahr 

 

 Ovisno o širini žetvenog uređaja, kolica se mogu produljiti na mjestu spoja srednjeg nosećeg 

dijela i ruda pomoću kojeg spajamo kolica na kombajn. Kako se kolica produljuju na mjestu spoja 

(rudo-srednji noseći dio) dolazi do nestabilnosti pri transportu većih uređaja (od 5,4 m do 7,2 m)  

zbog povećane mase tereta i nepravilnog raspoređenog tereta na kolicima.  

Na slici su prikazane vrste žetvenih uređaja podijeljeni po širini i njima pripadajućim masa 

koju kolica moraju podnijeti pri transportu (Slika 2.3). Također, uzrok nestabilnosti može biti i kruta 
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osovina koja nema suspenziju, teško se prilagođava grubljim terenima i kolica primaju svaki udarac 

o izbočinu ili propadanje u rupu 

 

Slika 2.3 Širina i masa žetvenog uređaja 

 

 Želja za poboljšanjem i povećanjem radnog zahvata žetvenog uređaja, rezultira uvođenjem 

novih tehnologija i samo proširenje uređaja. Danas se razvijaju novi žetveni uređaji širine 9 metara 

koji znatno premašuju masu od 2 tone. Postojeća kolica ne ispunjavaju uvjete za transport tako 

velikih uređaja zbog navedenih nedostataka. Rješenje je u novim kolicima koja će nositi žetvene 

uređaje svih širina i koja će se lako prilagoditi neravnim terenima s tandem osovinama i 

karakteristikama suspenzije "gibljive grede" (Slika 2.4). 
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Slika 2.4 Nova kolica sa tandem gibljivom gredom 

2.2. Tandem gibljiva greda 

Osim tipa torzijske šipke, zadnje suspenzije obično mogu biti kao "gibljiva greda","zavojne 

opruge","lisnate opruge (gibnjevi)" ili "zračne opruge" i kombinacije ovih nabrojanih vrsta. Bez tih 

generalnih podjela, mogući su drugi tipovi i izrađevine. Od svih tipskih podjela gibljiva, greda je 

najučinkovitija vrsta suspenzije kod transporta velikih masa i opterećenja.  

2.2.1 Razvoj gibljive grede 

Prva komercijalno uspješna tandem suspenzija se koristi i danas, naravno, uz mnoge 

preinake. Magnus Hendrickson (Slika 2.5), švedski imigrant, inženjer i industrijalac u Chicago-u, 

predstavio je 1926 godine prvi kamion sa tandem suspenzijom (Slika 2.6), na kojoj su montirane 

osovine na svakom kraju gibljive grede.  
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Slika 2.5 Magnus Hendrickson (desno) [1] 

 

 

Slika 2.6 Tandem gibljiva greda [1] 

Hendrickson je postavio par I-profila, jedan na svaku stranu kamiona paralelno sa konstrukcijom 

šasije, da bi tako povezao još dvije osovine. Osovine su spojene sa gredom na njenim krajevima, i 

svaka je greda povezana sa središnjom osovinom (osloncem) na svojoj težišnoj točki ( 

Slika 2.7). To omogućava gredi da se giba gore i dolje tj. oscilira, ali i da grede ostaju 

jednako udaljene jedna od druge. Ova je jedinstvena gibljiva greda napravljena da raspodijeli teret 

kamiona između dvije osovine i na taj način omogući bolje prianjanje na podlogu i ugodniju vožnju.  
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Slika 2.7 Gibljive grede u sklopu s osovinama 

 

Kod običnog tipa suspenzije, kao kod lisnate opruge, drugi će kotač (koji još nije udario 

izbočinu) također će biti podignut budući da su oba kotača spojena pojedinačno na šasiju. Ovo je 

opis normalne duple osovine, koja može naštetiti vozilu i kolniku.  

U slučaju uzdužne tandem suspenzije (gibljive grede), cijeli je sistem nagnut oko uporišta 

(osovine) te iako je prednji kotač podignut zbog izbočine, zadnji kotač ostaje sam na nižoj površini i 

ostvaruje kontakt sa podlogom (Slika 2.8). Na taj se način izbjegavaju prekomjerni udarci  na 

suspenziju i osovinu. Vertikalni su hod ili "artikulacija"
1
 osovine ograničeni s graničnicima na 

okviru (šasiji). 

                                                 
1
 Artikulacija osovine - sposobnost kretanja  jedne osovine u odnosu na šasiju – jedan kotač gore, drugi dolje (neovisna 

suspenzija) ili ne (usporedna kruta osovina). 
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Slika 2.8 Shema gibljive grede 

 

Tvrtka je Hendrickson i danas jedna od vodećih u proizvodnji suspenzija za kamione i 

prikolice. Neki sistemi suspenzija još uvijek koriste gibljive grede u  kombinaciji s drugim oblicima 

suspenzija kao npr. gibljiva greda u kombinaciji s lisnatim oprugama, gumenim suspenzijama, 

zračnim jastucima i sl. Jedan od primjera takvih sustava, koji koriste gibljivu gredu, je Serija RT . 

Značajka su ove serije lisnate opruge. Skup lisnatih opruga vezan je za sklop gibajuće grede dok 

držači opruge vežu sklop za šasiju (ramu) kamiona. Nosivost ovog sustava je  30 000 kg  

( 

Slika 2.9). 

 

 

Slika 2.9 Gibljiva  greda s lisnatim oprugama [2] 
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Varijante su gibljive grede dostupne i kod drugih proizvođača. Jedan je od primjera Air-Link 

suspenzija iz Raydan Manufacturing-a. Zračni su jastuci postavljeni iznad gibljive grede da bi 

vožnja tako bila što ugodnija. Ovi se tipovi, također, primjenjuju za vožnju po grubim terenima i 

američka ih vojska koristi na svojim kamionima. Nosivost je ovakvog sistema suspenzije oko 38 

000 kg (Slika 2.10). 

 

 

Slika 2.10 Air-link gibljiva greda sa suspenzijom zračnih jastuka 

 

Uz još brojne nespomenute sisteme suspenzija sa gibljivom gredom, postoje vozila koja 

koriste pogonjene tandem gibljive grede da bi se tako lakše kretala preko grubih i neravnih terena 

uslijed svoje robusnosti i velike mase. Jedan je od primjera takvih strojeva motorni greder, stroj za 

obradu zemljane površine (Slika 2.11). 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

10 

.  

Slika 2.11 Greder s pogonskim tandem osovinama [3] 

 

Grupa tandem kotača se pokreće pomoću hidrauličke ili mehaničke snage da bi se zavrtio 

jedan kotač ili više kotača u grupi. Takve konstrukcije osovine imaju dva kotača koja se pokreću, po 

mogućnosti imaju jednake momente, tako da pogonjene tandem osovine ostaju balansirane i 

stabilne.  

Tipična konfiguracija pogona za tandem osovine uključuje rotirajući lančanik koji pokreće 

jedan ili više kotača u grupi s lancima i hidraulične kočnice s više diskova. Kočnice, lanci i 

pripadajući lančanici se nalaze unutar gibljive grede koja je spojena sa strojem preko pokretne 

osovine. Lanci su raspoređeni tako da daju jednaki okretni moment svakom kotaču, u protivnom će 

jedan kotač pokretati cijelu grupu kotača gdje dolazi do nestabilnosti (Slika 2.12). 

 

 

Slika 2.12 Konfiguracija pogonske gibajuće grede [3] 
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2.2.2 Transportna kolica sa gibljivom gredom 

Prikolice su jedan od najvažnijih priključaka u području poljoprivredne mehanizacije jer 

omogućuju transport različite robe i dobara. Prikolice se obično dijele prema broju osovina:  

 Jednoosovinske –odlikuje ih velika okretnost i budući da obično imaju niže težište, dobre su 

za rad na strmim terenima. 

 Dvoosovinske – prikolice za veliku nosivost i veliki volumen; najčešće se koriste u velikim 

domaćinstvima za prijevoz uroda 

 Tandem – prikolica s dvije osovine na stražnjem kraju prikolice; koriste se također za 

prijevoze veće količine tereta 

 Univerzalne – prikolice koje se koriste za različite namjene 

Prikolice za transport žetvenog uređaja kombajna, koje se trenutno proizvode u tvornici 

Same Deutz Fahr, jednoosovinskog su karaktera jer pojednostavljuju konstrukciju i ispunjaju uvjete 

za transport manjih žetvenih uređaja. Tvornica je kombajna Same Deutz Fahr krenula korak dalje i u 

proizvodnji kolica, razvijanjem tandem kolica sa gibljivom gredom (Slika 2.13). 

 

Slika 2.13 Tandem kolica sa gibljivom gredom 
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 Preduvjeti su za razvoj novih kolica u tvornici: jednostavnost, funkcionalnost i niski 

troškovi izrade.  

Inovacija su gibljive grede koje pružaju stabilnost kolica pri transportu, jednostavne 

konstrukcije s funkcijom suspenzije.  

 

Slika 2.14 prikazuje glavne dijelove sklopa gibljive grede i može poslužiti kao smjernica pri 

sastavljanju sklopa u proizvodnji. Iz slike se može zaključiti da je gibljiva greda jednostavne 

konstrukcije i da njezina izrada nije zahtjevna što je u skladu s nižim troškovima izrade kolica i 

pristupačnom konačnom cijenom proizvoda. 

Sastavni dijelovi desne gibljive grede: 

1. Zavareni sklop desne konzole koja se sastoji od: 

 dvije identične limene oplate 

 dva rukavca 

 čahure za klizni ležaj 

 lim za skidanje žetvenog uređaja 

2. Čahura kao posteljice za klizni ležaj 

3. Industrijski ležaj ø18x80x40 

4. Glavčina 

5. Industrijski ležaj  

6. Podloška ø 13x44x6 

7. Vijak M12x1,75x3 

8. Elastična podloška  

9. Mazalica 

10. Osovina  

11. Podloška 

12. Rascjepka 

13. Prsten 

 

Zavareni je sklop konzole (pozicija 1) sastavljen od dvije savijene limene ploče debljine od 5 

mm koje su spojene čeonim zavarivanjem na spojevima dva lima. Prije savijanja ploča, probijene su 

rupe u kojima će kasnije biti zavareni rukavci (1b) i čahura za klizni ležaj (1c) koji pri zavarivanju 
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također spajaju dvije identične oplate i čine spoj krućim. Na konzolu je navaren i graničnik, komad 

lima koji pomaže pri skidanju žetvenog uređaja s kombajna na kolica. Dalje se sklapaju ostali 

dijelovi u konačni sklop. 

 

 

 

 
 

 

 

Slika 2.14 Sastavni dijelovi desne gibljive grede za transportna kolica 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

14 

3. ODABIR RAČUNALNOG ALATA - SIEMENS PLM NX 

Sustav je Siemens PLM NX odabran zbog sveobuhvatnosti i mogućnosti nadogradnje 

modulima za određena područja konstruiranja. U ovom su poglavlju predstavljeni moduli Siemens 

PLM NX programa koji omogućuju tvrtkama efikasnu i efektivnu inovativnost, te upravljnje čitavim 

nizom usluga koje su vezane za pojedine faze životnog ciklusa proizvoda. Odabiru ovog programa 

doprinijela su pozitivna iskustva uspješnih tvrtki koje koriste Siemens PLM NX, ali i brojna 

priznanja. 

NX (nastao spajanjem Unigraphics i I-DEAS programa) je složeni CAD/CAM/CAE sustav 

koji obuhvaća veliki spektar poslova pri konstruiranju i proizvodnji sustava: od stvaranja prvog 

idejnog prijedloga, simulacija i analiza, modeliranja pojedinačnih dijelova i sklopova, izrade 2D 

dokumentacije, programiranja CNC strojeva pa sve do do kontrole kvalitete. NX je sustav koji 

omogućuje upravljanje podacima i spajanja s raznim informacijskim sustavima u poduzeću, kao što 

je Teamcenter sustav. [4] 

NX se sastoji od potpuno međusobno asocijativnih modula koji ujedinjuju radno okruženje i 

jedinstveno grafičko objektivno orijentiranu bazu podataka. Bazu podataka koja omogućuje 

paralelni rad inženjera (engl. Collaborative Engineering). U praksi to znači da je u nekom trenutku 

razrade modela, moguće u isto vrijeme obavljati simulaciju proizvodnje dijela na CNC stroju, izradu 

2D dokumentacije ili analizu čvrstoće modela. [4] 

 

  NX program se sastoji od nekoliko modula: 

 Moduli za konstruiranje (CAD) 

 Moduli za projektiranje raznih vrsta alata 

 Moduli za simulaciju proizvodnje na CNC strojevima (CAM) 

 Moduli za specijalne oblasti strojarstva  

 Moduli za simulacije metodom konačnih elemenata (FEM,CAE) 

3.1. NX CAD  

 NX CAD sustav za konstruiranje s alatima za izradu 3D modela i upravljanje s njima ima 

bazu za modeliranje pogodnu za različite industrijske potrebe i potpuno integrirano upravljanje 

konstrukcijama. CAD sistem omogućuje inženjerima jednostavan razvoj proizvoda, od osnovnog 
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dijela do konačnog sklopa. Prilagođene naredbe sa smislenim tijekom kreiranja ubrzavaju 

konstruiranje, kontroliranje i promjenu elemenata unutar sklopa.  

Modeliranje sa NX CAD modulima : 

 Modeliranje Solid (volumnih) dijelova 

 Modeliranje dijelova od lima 

 Modeliranje žice i kablova 

 Čovjek, prostor, ergonomija, antropometrija
2
 

 Montaža 

 Tiskane pločice za električne krugove 

 Konstruiranje limenih dijelova za zrakoplovnu industriju 

 Konstruiranje alata za štancanje 

 Projektiranje kalupa za izradu dijelova od plastike 

 

3.2. NX CAM 

NX CAM je softversko rješenje za digitalni razvoj proizvoda tvrtke Siemens PLM Software. 

Sveobuhvatan je i  provjeren sustav za programiranje CNC alatnih strojeva (Slika 3.1). Uključuje 

najsuvremenije tehnološke postupke i napredne metode za povećanje učinkovitosti proizvodnje alata 

i izradaka. Uz NX CAM, tvrtke mogu ažurirati postupke i procese NC programiranja, smanjiti otpad 

i značajno povećati produktivnost resursa – kako ljudi, tako i strojeva.  

 

 

Slika 3.1 Slijed razvoja proizvoda pomoću alata NX CAM  

 

                                                 
2
 Antropometrija (grč.), dio antropologije koji se bavi mjerenjem ljudskog tijela i pojedinih njegovih dijelova. 
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NX CAM je u potpunosti integriran s programskim alatom NX za razvoj proizvoda. 

Zadovoljava sve potrebe NC programiranja, pisanja i korištenja postprocesora, pokaza putanje alata 

i simulacije kretanja stroja. Osim toga, najnovije tehnike modeliranja omogućuju modeliranje 

proizvoda, alata i držača, kao i samog alatnog stroja za potrebe simulacije i složenih obrada. [5] 

Mogućnost CAM modula (Tablica 3.1)(Slika 3.2): 

 

Tablica 3.1 Mogućnosti Siemens PLM NX CAM modula [5] 

 

GLODANJE KONSTRUIR- 

ANJE 

PRIPOMOĆ 

 ZA 

AUTOMATIZ- 

ACIJU 

PROVJERA I 

SIMULACIJA 

OSTALO 

 2 – i 3-osno 

glodanje 

 5-osno glodanje 

 Bušenje 

 Automatska 

obrada blokova 

 Obrada visokim 

brzinama 

 Graviranje 

 Konstruiranje 

prihvata 

 Modeliranje 

dijelova i 

sklopova 

 Prevoditelj 

geometrijskih 

zapisa 

 Procesne 

podloge 

 Knjižnica alata 

 Tehnološki 

podaci 

 Provjera putanje 

alata  

 Modeliranje 

kinematike 

alatnog stroja  

 Simulacija rada 

alatnog stroja 

 Aplikacija za 

izradu 

postprocesora  

 Ispis 

proizvodne 

dokumentacije  

 Upravljanje 

podacima 

 

 

 

 

Slika 3.2 Mogućnosti Siemens PLM NX CAM modula 
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3.3. NX CAE 

Siemensova je CAE vizija dostaviti simulacije inženjerskih rješenja koja će odlučivati o 

upravljanju  performansi proizvoda kroz cijeli proizvodni ciklus. Siemens je poboljšao i formirao 

svoje proizvode: Nastran, SDRC i I-DEAS  u NX™ CAE program.  

 Učinkovito korištenje simulacije može pomoći voditeljima projekta u smanjenju mnogih 

troškova i rizika. CAE simulacije omogućuju inženjerima razumjeti, predvidjeti i digitalno 

poboljšati performanse proizvoda. Koncept dizajna tako se može više istražiti što zauzvrat smanjuje 

izravne troškove povezane sa skupim stvarnim izradama prototipa i omogućuje više promišljenih 

odluka. Ključ je povećanja vrijednosti simulacijskih značajki zajedničko korištenje u što ranijoj fazi, 

ako je to moguće, i daljnje razvijanje kroz proces.  

CAE rješenja:  

 NX Scenario – za brzu procjenu čvrstoće, strujanja (Slika 3.3), toplotnih stanja i 

gibanja  

 NX Master FEM – (od ranije poznat kao I-DEAS Master FEM)  

 NX Nastran  

 

 
 

Slika 3.3 Simulacija strujanja -Flow NX CAE 
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3.4. NX korisnici 

Ruska zrakoplovna industrija (Russia's United Aircraft Corporation) koristi NX i 

Teamcenter sustav. Borbeni avioni poput Sukhoi (Slika 3.4), kao najsloženiji sklopovi u strojarskoj i 

elektro struci, predstavljaju najveći izazov u projektiranju. Ovaj izazov ne zahtjeva samo maksimum 

od svih ljudi uključenih u proces, nego i maksimum  od strojeva, softvera i organizacije. [6] 

 

Slika 3.4 Slika aviona Sukhoi Su-30  

 

 

Red Bull Racing Formula 1 Team je korisnik NX i Teamcenter softverskih proizvoda (Slika 

3.5). U NX softveru, inženjeri na jednostavan način konstruiraju sve komponente, vrše ispitivanja i 

sve što je potrebno da ih prilagode prije početka stvarne proizvodnje. Rezultat je dvostruki naslov 

svjetskog prvaka Red Bull tima u konkurenciji vozača i konstruktora. 
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Slika 3.5 Red Bull Racing Formula 1 

 

U nastavku su nabrojani smo neki od najpoznatijih tvrtki koje koriste NX CAD/CAM/CAE 

program: 

Boeing Commercial Airplanes  

NASA 

Samsung 

Aston Martin 

Nissan Motor co.,Ltd. 

GM Daewoo 

Mazda Motor Corporation 

Ducati Motor Holding S.p.A 

Phillips Plastics Corporation 

MAN B&W Diesel 

Canon Inc. 

Honda Racing F1 Team 

Saab Automobile AB 

John Deer  

 

Sa 7 milijuna licenciranih mjesta i više od 71.000 kupaca širom svijeta, Siemens PLM 

Software  proizvodi se koriste u više od 90% svjetskih TOP-15 automobilskih proizvođača 

originalne opreme. U stvari, Siemens PLM Software ima udio u razvoju više od 80% svih vozila 

proizvedenih u svijetu od strane svih 47 vodećih svjetskih proizvođača originalne opreme, što je 

rangirano od strane Međunarodne organizacije proizvođača motornih vozila (engl. International 

Organization of Motor Vehicle Manufacturers – OICA) [6]. 
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4. POSTUPAK IZRADE DIGITALNE DOKUMENTACIJE 

U prvom je dijelu ovog poglavlja opisana osnovna metoda kreiranja modela i izrada 

tehničkih crteža, dok je u drugom dijelu poglavlja (kroz realan primjer) opisan postupak slaganja 

digitalne dokumentacije i način vođenja dokumenata. 

4.1. Konstruiranje proizvoda 

Većina se tvrtki služi 3D modeliranjem i vizualizacijom da bi što brže izradile prototipove 

proizvoda u cilju ostvarenja visoke preciznosti i fleksibilnosti te učinkovitog kreiranja i 

modificiranja 3D modela. Prostorno je modeliranje zapravo prva faza kreiranja svakog cjelovitog 

projekta.  

Za kreiranje 3D modela, inženjeri se služe programima koji pripadaju skupini CAD 

(Computer-Aided Design). Ti su alati osmišljeni za oblikovanje virtualnog objekta i sadrže mnogo 

dodatnih informacija o dimenzijama, materijalima i sl. CAD programski alati podržavaju različite 

načine modeliranja i oblikovanja objekta.  

Trodimenzionalni 3D prikaz ima veliku prednost, pogotovo kod primjene računala u procesu 

konstruiranja. Tako konstruirani prostorni objekt posjeduje sve informacije potrebne za izradu, 

proračun i analizu, simulaciju i kontrolu. Realan izgled modela pruža posebnu pogodnost i za 

industrijski dizajn. Crtež se dobiva na automatiziran način na osnovu dobivenog 3D modela.  

NX CAD alat za industrijsko oblikovanje osigurava modeliranje slobodnih oblika (engl. 

Free-Form) u modulu Shape studio, velikih sklopova u Assembly modulu, stvaranje vlastitih 

tvorbenih funkcija (User-Defined Features), komponenti napravljeni od lima (Sheet Metal), 

projektiranje cjevovoda i električnih veza (engl.Roted System Design) i na kraju izradu tehničke 

dokumentacije.[5]  

Grafičko sučelje ( 

Slika 4.1) omogućuje interakciju korisnika i objekta, gdje se vidi radni prostor za stvaranje 

3D modela. Reasource bar (lijevo u sučelju) omogućuje editiranje, dodavanje, brisanje, kopiranje, te 

hijerarhijski prikaz dijelova i sklopova u obliku stabla, što može biti vrlo korisno kod složenijih 

sklpova. 
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Slika 4.1 Grafičko sučelje Siemens NX  

 

Uz parametarsko modeliranje, bazirano na značajkama, i direktno modeliranje,  NX pruža 

eksplicitno određivanje žičanih, površinskih, i volumnih modela. Ovi tradicionalni alati za 

modeliranje omogućuju dizajnerima da rade s 2D i 3D oblicima, koristeći skupinu operacija koje 

uključuju definiranje linija i krivulja: swept, revolved i loft solid i Boolean operacija za dodavanje, 

oduzimanje, i presjeke volumnih tijela te precizno modeliranje površine preko mreže linija ili 

točaka. 

Za kreiranje je modela potrebno uključiti opciju Sketch, zatim odabrati ravninu na kojoj se 

oblikuje skica, parametarski ili eksplicitno. Pomoću komande za izvlačenje (ekstrudiranje) dobiva se 

3D objekt - Ekstrude. Skica ne mora biti precizno nacrtan presjek, već približna kontura koju je 

dalje moguće parametarski ili eksplicitno definirati ograničenjima. Daljnji se postupak svodi na 

obradu 3D objekta operacijama koje su identične tehnološkim, odnosno operacijama kod alatnih 

strojeva kao što su bušenje, upuštanje, razvrtanje, narezivanje navoja i dr.  

Prelaskom u Drafting modul, moguće je izraditi radionički crtež. Crteži se generiraju na 

temelju modela i prenose karakteristike modela u 2D  prikaz. Iz modela se može dobiti 2D pogled iz 

bilo kojeg položaja (tlocrt, nacrt, bokocrt i dr.). Na crtežu se mogu dodati znakovi obrade, 

pozicioniranje i kotiranje po normama ASME Y14.41, ISO 16792 i JEITA. 
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4.2. Upravljenje dokumentima 

Upravljanje životnim ciklusom proizvoda (PLM) je proces upravljanja cijelim životnim 

vijekom  proizvoda: od njegovog koncepta, preko dizajna i proizvodnje, sve do korištenja i 

uklanjanja. Također, tvrtke i kompanije koje među svojim djelatnostima imaju uključenu i 

proizvodnju, moraju razviti, opisati, definirati, upravljati i razmjenjivati informacije o svojim 

proizvodima, a upravo je to ono što PLM (kao informacijska tehnologija) modelira.  

Teamcenter Engineering je PLM sistem kojim se koristi tvrtka Same Deutz Fahr i 

omogućuje praćenje i vođenje podataka kao što su: sastavnice, CAD/CAM/CAE datoteka, 

konfiguracije sklopova, verzije komponenti i sklopova, nacrti i ostali projektni dokumenti, 

odgovarajući zapisi za 3D vizualizaciju, itd. [5].  

PLM sistem pomaže inženjerima i drugim uključenim u razvoj proizvoda u upravljnju 

podacima i proizvodnim procesima vezani uz proizvod. Za lakše praćenje i vođenje podataka, 

potrebno je pravilno odrediti radikal proizvoda. Radikal je oznaka skupa komponenti koji čini 

proizvod. Primjerice na početku sezone u tvrtci Same Deutz Fahr određuje se radikal za svaku 

seriju: 

H9.QA5F2.25.0 

 QA5F2-radikal, sastoji se od dva dijela: 

 QA5 - oznaka serije kombajna 6000 E3B za 2012.-tu godinu  

(npr. serija 6000 E3A za 2011.-tu godinu prvi dio radikala je QB2.) 

 F2 - oznaka limene oplate 

 .25 – u ovom slučaju oznaka za lijeva panela vrata. 

 Dakle, oznaka se za vrata na modelu iz 2011.-te i 2012.-te godine razlikuje samo u prvom 

dijelu radikala (H9.QA5F2.25.0 za 2012. g.i H9.QB2F2.25.0 za 2011. g.). Ako se oznaka za vrata 

koristi samo za izvedbu kombajna od 5 slamotresa, prvi je dio radikala "QB5", a ako se spomenuta 

oznaka korisiti i na izvedbama od 5 i 6 slamotresa za izvedbu kombajna od 6 slamotresa, njegov je 

početni radikal "QA5". 

Serija 6000 obuhvaća sve 60xx kombajne (6060, 6065, 6090,6095). Struktura se serije 6000 

E3B  sastoji od više H7 grupa koje čine  H6 grupe nastale od H9 grupa koje sadrže zavarene- i 

vijčane sklopove, te pojedinačne pozicije. Slika 4.2. prikazuje grupu H6 za kombajn od 6 slamotresa 

iz serije 6000. 
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Slika 4.2 Upravljanje sklopova –Assembly Navigator  
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5. IZRADA DIGITALNE DOKUMENTACIJE GIBLJIVE GREDE 

U ovom je poglavlju prezentiran razvoj modela, kao i izrada dokumentacije gibljive grede. U 

tu svrhu je objašnjen postupak rada kod kreiranja 3D objekata, a zatim i montaža dobivenih 

elemenata u sklop. 

Kroz primjere je prikazana  mogućnost Siemens NX programa (kod dodavanja dijelova u 

sklop i drugih izmjena u samom sklopu) koja znatno ubrzava rad i tako omogućuje konstruktoru da i 

tijekom procesa prati tok svojih razmišljanja pri kreiranju modela. 

Osim toga, bit će objašnjeni osnovni postupci modeliranja dijelova, kao i postupci 

definiranja ograničenja među dijelovima u sklopu i nastanak konačnog modela, kroz dijelove koji 

čine sklop gibljive grede (Slika 5.1). 

 

Slika 5.1 Prikaz sastavnih dijelova sklopa Gibljiva greda 
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5.1. Radno okruženje programa 

Pri pokretanju programa, pojavit će se osnovno sučelje programa Siemens NX (Slika 5.2). 

Preko njega se izabire modul, odnosno, radni prostor. Za kreiranje nove datoteke bira se opcija New. 

 

 

Slika 5.2 Osnovno sučelje programa Siemens NX 

 

Ova opcija otvara prozor preko kojeg se kreira nova datoteka - New (Slika 5.3). Može se 

izabrati jednu opciju od nekoliko ponuđenih, ovisno o projektu na kojem se radi.  

 

Na gornjim karticama prozora, ponuđene su radne značajke : 

 

 Model - u ovom se odijelu nalaze moduli za izradu modela 

 Drawing - je modul za izradu tehničkih crteža 

 Simulation - moduli za izradu simulacija (CAE) 

 Manufacturnig - moduli za prikaz proizvodnje (CAM) 

 Inspection - moduli za kontrolu kvalitete modela 
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Pod karticom Model, u okviru Templates (predlošci), nalaze se predlošci raznih modula   

(Slika 5.3):  

 Model - modul za izradu modela, sklopova i prikaz zavarenih spojeva 

 Assembly - u kojem se vrši spajanje pojedinih dijelova i sklopova 

 Shape studio - modeliranje se vrši  preko slobodnih oblika površine pomicanjem     

rubova, točaka, što se automatski prikazuje na modelu. 

 NX Sheet Metal - u okviru je ovog modula moguće dizajniranje dijelova od lima i  

mogućnost prikaza razvijenog stanja dijelova od lima 

 Aero Sheet Metal - za modeliranje limenih dijelova za zrakoplovnu industriju 

 Routing Logical - modul za logičko usmjeravanje 

 Routing Mechanical - modul za usmjeravanje cijevi  

 Routing Electrical - modul za usmjeravanje električnih instalacija  

 

 

 

Slika 5.3 Prozor za kreiranje nove datoteke -New 
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U predlošcima se nalazi opcija Units u kojoj se odabiru mjerne jedinice. Pri dnu prozora 

New, nalazi se okvir New File Name za definiranje imena i lokacije datoteka koje se generiraju te 

ostala podešavanja vezana za lokaciju standardnih i drugih dijelova u okviru programa. Ime može 

biti broj kojim se definiraju model i crtež dijela.  

Dio ne mora biti spremljen u neku određenu mapu. Da bi se tako pronašao, dovoljno je 

upisati njegov broj na koji se dio poziva. Ne postoje dva ista broja na serveru.  

Primjerice, u tvornici kombajna Same Deutz Fahr zadaju se brojevi oblika: 0.019.2568.0. Kada 

indeks dođe do ovog oblika 0.019.999, automatski se prebacuje u 0.020.001. Tako se broji za svaki 

dio za koji je izrađen model i crtež, u svakoj tvornici koja pripada grupaciji Same Deutz Fahr. 

5.2. Oblikovanje 3D objekta 

Kod kreiranja modela u Siemens NX,  potrebno je u sučelju New odabrati jedinice (Units) u 

milimetrima. Zatim, pod karticom Model izabrati opciju Model. Nakon izbora dobiva se osnovni 

prozor za skiciranje. 

Za prikazivanje osnovnih funkcija izrade modela, kao primjer će poslužiti dio Graničnik iz 

zavarivačkog sklopa Gibljiva greda. Dio je zadržan i za prikazivanje Boolean operacije dodavanja i 

oduzimanja volumnih oblika od postojećeg modela.  

Skica profila ili samo skica je približni ravninski obris značajke. Skice su obično zatvorenog 

neprekinutog oblika sastavljene od linija i kružnih lukova, ali mogu biti otvorene tako da se prilikom 

određivanja značajke iskoristi brid modela [7]. 

Za kreiranje je modela potrebno prvo izraditi skicu alatom Sketch. Odabirom alata za 

skiciranje pojavljuje se prozor za izbor radne ravnine u aktivnom koordinatnom sustavu (Slika 5.4). 

Za vrijeme kreiranja modela, moguće je definirati dodatne radne površine za potrebe skiciranja, a 

kao radne površine mogu poslužiti i površine modela koji se kreira. 
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Slika 5.4 Odabir radne ravnine 

Skica se crta približno ili točnih mjera kao buduće značajke i pri tom se koriste alati za 

crtanje koji se nalaze na traci za direktno skiciranje (Direct Sketch ) profil, linija, luk, krug (Profile, 

Line, Arc, Circle) i dr. Zatim se uvode određena ograničenja između segmenata skice da bi se 

definirao njezin konačan izgled. Ograničenja koja se uvode za definiranje skice nalaze se na Direct 

sketch traci Inferred Dimensions. Koriste se za definiranje dimenzija odnosno rastojanja između 

pojedinih segmenata skice, kao i za definiranje odnosa između ostalih elemenata na dijelu koji se 

modelira, a ovisno od ravnine u kojoj se skica nalazi (Slika 5.5).  

 

Slika 5.5 Skiciranje i postavljanje ograničenja  
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Za definiranje skice koriste se kote, koje su parametarske i automatski se upisuju u tablicu sa 

parametarskim dimenzijama - Expressions. Tablicu pozivamo preko izbornika Tools ► Expressions. 

U Expression-u moguće je definirati i tzv. korisničke parametre, prije ograničavanja i 

dimenzioniranja skice.   

Odabirom opcije Spreadsheet Edit, omogućuje se unošenje parametara modela u program 

Microsoft Office Excel gdje se parametri mogu dorađivati i ponovno primijeniti na model. 

Vrijednosti za parametre modela dobivaju se izravnim unosom broja, jednakošću s korisnički 

unesenim parametrima, međusobnom ovisnošću dvaju parametara modela ili preko jednadžbe u 

ovisnosti o korisničkim parametrima. 

 

 

 Slika 5.6 Tablica za uređenje parametara -Expressions 

 

  Geometrijskim ograničenjima smanjujemo vrijeme potrebno za postavljanje i održavanje 

parametarskih mjera.  Prije postavljanja parametarskih mjera na profil, postavljaju se geometrijska 

ograničenja u što većem broju.  

 Geometrijska je ograničenja međusobnih odnosa segmenata na skici moguće odrediti 

pokretanjem opcije Constraints (Slika 5.7) koja se nalazi na alatnoj traci Sketch. U geometrijskim 

ograničenjima moguće je odabrati glavnu liniju, opcijom Fixed, i na njoj ostala ograničenja (mjere, 

paralelnost, pravi kut, jednakost i dr). 
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Slika 5.7 Prozor sa geometrijskim ograničenjeima 

 

Nakon što je skica definirana, gumbom Finish Sketch izlazi se iz moda za skiciranje. 

Pokretanjem alata za ekstrudiranje -Extrude, dobiva se efekt 3D objekta kojeg je potrebno naknadno 

"obraditi"  kako bi se dobio odgovarajući oblik. U prozoru Extrude, definiraju se duljina razvlačenja 

(ekstrudiranja), smjer vektora,  Boolean operacija i drugo (Slika 5.8). 

 

 

Slika 5.8 Ekstrudiranje -Extrude 

 

Na Slika 5.9a prikazan početni model, a držanjem desne tipke miša na sučelju prikazuju se 

ikone za uređenje pogleda modela kao ispunjenog dijela sa sjenom. Ovaj pogled koji prikazuje samo 

konturu (Slika 5.9b) ili opciju za prelazak u studio (Slika 5.9c). U studiju se dobiva realan izgled 

modela, a moguće je definirati i boju, teksturu, kut svijetla i sjenu. 

 

 

 

 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

31 

     a) b)      c) 

 

Slika 5.9 Ekstrudirani početni model 

 

Nakon osnovnog oblikovanja modela,  koriste se ostali alati za daljnju obradu sve dok se ne 

postigne željeni oblik modela. 

Za nastavak se crtanja mogu iskoristiti i površine na već kreiranom modelu. Ravnine se 

mogu odrediti držanjem strelice i lijevim klikom miša na objekt. Pokazuje se prozor s ponuđenim 

opcijama za brzi izbor (engl. Quick Pick). Ponuđene opcije mogu biti: ravnina objekta ili prethodne 

radnje Extrude, Revolve i sl. (Slika 5.10). Postoji i drugi pristup, ponovno pokretanje opcije Sketch 

koji za početak skiciranja traži odabir ravnine, da bi se nastavilo sa skiciranjem i zadavanjem 

ograničenja. Za skiciranje je odabrana opcija Circle (krug) na alatnoj traci Sketch (Slika 5.11) 

 

 

 Slika 5.10 Brzi izbor radne površine  
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Slika 5.11 Primjer skiciranja na modelu 

 

 Kada su krugovi definirani, pozove se naredba Extrude i pod opcijom Boolean izabire se jedna 

od naredbi: spajanje (Unite), isijecanje (Subtract) ili presjek (Intersect).  

Na  

Slika 5.12 prikazano djelovanje opcije Unite (dodaje se virtualno volumno tijelo koje polazi od skice 

na površini već nastalog modela).  

Slika 5.13 prikazuje djelovanje opcije Subtract (od modela se oduzima volumno tijelo koje polazi 

također od skice na površini modela). Ovo je jedan od načina izrade provrta na modelu. Provrte je 

na modelu moguće izraditi i alatom Hole koji se nalazi na alatnoj traci ili na izborniku Insert ► 

Design Feature ► Hole. 
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Slika 5.12 Brzi izbor radne površine 

 

 

Slika 5.13 Primjer skiciranja na modelu 

 

Navedene su neke od osnovnih funkcija za kreiranje modela. Većina tih funkcija koristiti se 

za izradu modela nekih dijelova sklopa gibljive grede. Dijelovi su navedeni i prikazani: 

 Podloška Ø50x70x4  (Slika 5.14) 

 Prsten Ø50x70x20 (Slika 5.15)  

 Osovina  (Slika 5.16) 
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 Čahura (Slika 5.17) 

 Kuglični ležaj ø18x80x40 (Slika 5.18) 

 

 

Slika 5.14 Podloška Ø50x70x4   

 

 
Slika 5.15 Prsten Ø50x70x20 
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Slika 5.16 Osovina 

 

 

 

 
Slika 5.17 Čahura u presjeku 
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Slika 5.18 Kuglični ležaj Ø18x80x40 

 

5.2.1 Oblikovanje urezanog navoja sa stožastim upustom 

 

Funkcija će izrade modela navoja sa stožastim upustom biti objašnjena na dijelu Rukavac. 

Dimenzije su za izradu središta sa urezanim navojem M12 očitane su iz DIN 332 norme.  

Nakon kreiranja modela rukavca, potrebno je napraviti dvije operacije da bi se dobio model 

urezanog navoja sa upustom. Prvo je potrebno izbušiti slijepi provrt sa urezanim navojem i izraditi 

stožasti upust.  

Za izradu slijepog provrta sa urezanim navojem, odabire se naredba Hole (rupa) na alatnoj 

traci ili preko izbornika Insert ► Design Feature ► Hole. Naredba otvara prozor sa  opcijama i za 

početak traži da se definira točka na modelu gdje će se rupa izbušiti i radnu površinu. Za ovaj je 

primjer dovoljno strelicom miša pokazati na rub osovine i program predlaže točku središta same 

osovine (mjesto na kojem je potrebno izbušiti provrt) ili strelicom miša se pokaže površina na 

modelu gdje je potrebno izbušiti provrt.  

Kada je definirano mjesto izrade provrta, u opcijama se definira vrsta provrta. Za početak, to 

je provrt s navojem (engl.Threaded Hole). Pod Thread Dimensions, odabire se veličina navoja sa 

već definiranim korakom, zatim se upisuju dimenzije, definira se smjer navoja (lijevi ili desni) i dr. 

Svi uneseni podatci i završetak operacije potvrđuju se pritistkom se dugme OK. Na modelu je 

urezani navoj prikazan simbolično, isprekidanim crtama oko provrta (Slika 5.19).  
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Za realan je 3D prikaz urezanog navoja potrebno napraviti običan provrt pozivanjem alata 

Hole, odabrati vrstu provrta -General Hole, ispuniti ostale uvjete za izradu željenog provrta te  

završiti postupak.  

Završetak postupka predstavlja pozivanje alata Thread, ispunjavanje uvjeta (označavanje provrta, 

smjera vektora i dr.) i određivanje dimenzije za izradu urezanog navoja. 

Nakon urezanog navoja na istom mjestu, istim se postupkom izrađuje stožasti upust (Slika 

5.20). Kod pozivanja naredbe Hole u opcijama pod Type (tip) odabire se General Hole, zatim se pod 

Form definira vrsta upusta, za ovaj slučaj to je stožasti upust. Definiraju se potrebne  dimenzije i 

dodatne opcije te završava se operacija. Slika 5.21 prikazuje konačan izgled provrta u kombinaciji 

sa stožastim upustom. 

 

 

Slika 5.19 Operacija urezivanja navoja 
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Slika 5.20 Operacija izrade stožastog upusta  

 

 

 

Slika 5.21 Rukavac sa urezanim navojem i stožastim upustom 
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5.2.2 Oblikovanje elementa alatom Revolve 

 Glavčina je strojni element iz sklopa Gibljiva greda,  cilindričnog je oblika i pravi primjer 

modela izrađenog alatom Revolve .  

 

  Korištenjem alata Revolve mogu se izraditi jednostavni i složeni 3D modeli iz 2D crteža koji 

su cilindričnog  karaktera, kao  osovina, vijak, bubanj, zamašnjak i drugi cilindrični proizvodi.  

 Revolve alat omogućuje kreiranje volumnog tijela okretanjem skice oko osi. To može biti 

skicirana linija ili rub postojeće značajke. Alat  Revolve zahtjeva sljedeća tri koraka za rad: 

 Odabrati skicu koja se rotira 

 Odabrati os oko koje se rotira 

 Odrediti ograničenja rotiranja 

 Nakon kreiranja skice i osi, pozove se alat Revolve preko izbornika Insert ► Design 

Features ► Revolve. Prvo se definira skica koju treba rotirati, zatim se pod Axis (os) određuje 

vektor oko kojeg se skica rotira i u okviru Limits određuju ograničenja rotiranja. U ograničenjima je 

-Limits potrebno odrediti početak i kraj rotiranja unosom vrijednosti (engl. Value) ili do odabranog 

(engl. Until Selected). Za ovaj je slučaj (Slika 5.22) vrijednost za početak rotiranja 0°, a za kraj 

360°. Tim se dobiva puni krug rotiranja. Ako se unese manji kut od 360° za kraj rotiranja, model će 

biti prikazan u presjeku, što je zgodno kod prezentiranja dijelova koji imaju složenu unutrašnjost 

(Slika 5.23).  

 

Slika 5.22 Rotiranje skice za 360° alatom Revolve 
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Slika 5.23 Rotiranje skice manje od 360° sa alatom Revolve  

 

 Za završetak je izrade dijela Glavčina potrebno izraditi zadebljanja prirubnice na pojedinim 

mjestima. Na zadebljanjima je potrebno napraviti provrt i urezati navoj.  

 Na prirubnici se glavčine kreira nova radna površina, opcijom Datum Plane koja se nalazi na 

alatnoj traci Feature. Na radnoj se površini skicira jedan od pet zadebljanja prirubnice, a za 

preostale se četiri skice pozove naredba Instnce Geometry (izbornik  Insert ► Associative Copy ► 

Instance Geometry). Za ovaj je slučaj potrebno postaviti rotirajući tip (Type: Rotate), zatim odabrati 

skicu objekta i vektor oko kojeg se skice rotiraju, kut, udaljenost i broj kopija objekta koji se 

izrađuje (Slika 5.24). Nakon toga, potrebno je ekstrudirati skice naredbom Extrude i izraditi provrte 

s urezanim navojem na zadebljanjima prirubnice (Slika 5.25). 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

41 

 

Slika 5.24 Skiciranje pojačanja prirubnice na novoj površini i naredba Instnce Geometry 

 

 

 

 

Slika 5.25 Konačni izgled glavčine sa presjekom 

 

 

 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

42 

5.2.3 Oblikovanje  modela od tankog lima- Sheet Metal 

Siemens NX sadrži alate koji pojednostavljuju izradu najčešće korištenih konstrukcija od 

tankih limova. Dopušta tvrtkama da svoja znanja prikupljena iz prakse i iskustva "pretoče" u 

vrijednosti koje se najčešće koriste za izradu dijelova od lima, kao npr. radijus savijanja i sl. što 

smanjuje vrijeme kreiranja dijelova od tankog lima. 

Komponentne od tankih limova mogu se kreirati pomoću raznih alata iz modula Sheet Metal. 

Općenito govoreći, puni se (solid) modeli limenih komponenti prave zbog generiranja razvijenog 

omotača limene komponente, proučavanja dizajna kalupa i otvora za proučavanje proizvodnog plana 

za projektiranje alata potrebnih za izradu limenih komponenti [7]. 

Osnovni je dio gibljive grede kutija koja je načinjena od dvije identične limene oplate koje su 

spojene čeonim zavarivanjem. Na elementima će biti objašnjena funkcija modeliranja objekta od 

lima. 

 Najčešći je način korištenja metode izrade modela limenih komponenti sljedeći: prvo se 

izradi osnovna ploča kojoj se zatim dodaju limeni tipski oblici dok se ne dobije zamišljena 

komponenta. U toj su metodi, svi parametri vezani uz osnovnu ploču, kao polumjer savijanja, 

dozvoljeno savijanje i kut rezanja [8]. 

Sheet metal modul se može pokrenuti na samom početku kreiranja nove datoteka. Na 

početnom se sučelju Siemens NX pozove opcija na izborniku File► New►Model►Templates -NX 

Sheet Metal. Otvara se novo sučelje za kreiranje dijelova od tankog lima. Svi se potrebni alati za 

kreiranje nalaze na alatnoj traci (Slika 5.26). 

 

Slika 5.26 Sučelje Sheet Metal 
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Za početak je rada potrebno pozvati naredbu Tab koja kreira osnovnu značajku 

ekstradiranjem skice duž vektora određeno debljinom (izbornik ► Insert► Tab).  Naredba se Tab 

pojavljuje nakon što je određena ravnina te se kreira skica sa unesenim ograničenjima (Slika 5.27). 

Skica se automatski ekstrudira kao virtualni objekt kojem treba odrediti debljinu lima (6 mm) i 

smjer vektora razvlačenja (ekstrudiranja). Time se dobiva osnovna limena ploča na kojoj se dodaju 

limeni tipski oblici. 

Izrada se osnovne ploče može se izvršiti i klasičnim putem, pokretanjem naredbe Sketch in 

Task u kojoj se skicira značajka i unose ograničenja.  Zatim, dodajemo volumen skici alatom 

Extrude gdje nastaje limeni dio. Zbog ovakvoga je postupka izrade modela u modulu Sheet metal 

potrebno definirati spomenuti model kao limeni dio (izbornik ► Insert ► Convert ► Convert To 

Sheet Metal). U suprotnom se slučaju ne bi mogli primijeniti ostali parametri za oblikovanje 

limenog dijela 

 

 

Slika 5.27 Skiciranje osnovne ploče 

 

Nakon što je kreirana osnovna ploča, potrebno je dodati obodne stranice. Obodne su stranice 

savijeni limeni zidovi napravljeni pod nekim kutom na rubu postojeće osovine ploče ili postojeće 

obodne stranice [8]. Obodna se stranica izrađuje alatom Flange koji se nalazi na alatnoj traci Sheet 

Metal ili preko izbornika Insert ►Bend ►Flange. Pojavit će se sučelje za kreiranje stranica. 

Potrebno je odabrati linearni rub planarne stranice, odrediti parametre stranice kao što su duljina, kut 

savijanja, radijus savijanja, vanjski ili unutarnji kut savijanja i dr. (Slika 5.28). 
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 Na osnovnoj ploči treba dodati preostale obodne stranice, kao što prikazuje Slika 5.29. Bočni 

se rubovi obodnih stranica ne dodiruju jer prate linearni rub osnovne ploče. Da bi se rubovi 

dodirnuli (spojili), u ovakvim slučajevima, treba pozvati naredbu Closed Corner na alatnoj traci 

Sheet Metal ili preko izbornika Insert ► Corner ► Closed Corner. Pojavljuje se sučelje na kojem 

treba odabrati stranice koje treba spojiti, vrstu spoja (otvoreni, zatvoreni, otvoreni u obliku kruga i 

dr.) (Slika 5.30) 

 

Slika 5.28 Izrada obodne stranice  

 

Slika 5.29 Dodatne obodne stranice na osnovnoj ploči 
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Slika 5.30 Sučelje za spajanje rubova obodnih stranica 

Na Slika 5.31 prikazan razvijeni oblik oplate polutke gibljive grede. Bitno je razviti model 

od limova, jer su na njemu prikazane gabaritne mjere od kojih se dobiva konačan oblik proizvoda 

linije savijanja lima. Flat Pattern se radi i zbog šablone koja se izrezuje laserom na limu u 

proizvodnji. Razvijeni se oblik dobije Flat Pattern alatom (izbornik Insert ► Flat Pattern ► Flat 

Pattern). Potrebno je odrediti površinu osnovne ploče oko koje se razvijaju obodne stranice i 

radijusi savijanja. 

 

Slika 5.31 Razvijeni oblik oplate -Flat Pattern 
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5.2.4 Modeliranje sklopova gibljive grede 

Sklapanje ili modeliranje sklopa (engl. Assembling Part) u domeni računalom podržanog 

konstruiranja je postupak kombiniranja nekoliko računalnih modela dijelova ili podsklopova 

postavljanjem međusobnih geometrijskih ograničenja. Postavljanjem se geometrijskih ograničenja 

pojedinom dijelu oduzimaju stupnjevi slobode kretanja u odnosu na drugi dio. 

 Modeli su dijelova pohranjeni u zasebnim datotekama na serveru i umeću se u datoteku 

sklopa kao instance. Pri tome je moguće umetnuti više instanci istog modela. Primjerice, za slučaj 

sklopa Gibljiva greda čija je osnova sastavljena od dvije identične limene oplate,  dva ista rukavca i 

glavčine. Dijelovi se umetnuti u datoteku sklopa označavaju kao vanjske reference sklopa (engl. 

External Reference). 

Postoje  dva  načina  modeliranja  sklopa, od vrha prema dnu (engl. top-down) i od dna  

prema  vrhu (engl. bottom - up). Siemens NX podržava oba pristupa modeliranja. Za projektiranje je 

gibljive grede korišten pristup od dna prema vrhu, najčešće korišten pristup u modeliranju sklopova. 

Ovaj pristup započinje sa izradom svakog pojedinog dijela koji se nalazi u sklopu, a sklapanje slijedi 

kada je izrada svih modela dijelova pri završetku. Takav postupak sklapanja nalikuje montaži 

proizvoda u procesu proizvodnje.  

Modul se za rad sa sklopovima (Assembly) pokreće kod kreiranja nove datoteke na sučelju 

New. Potrebno je odabrati Assembly modul u predlošcima Templates i sačuvati datoteku na željeno 

mjesto. Otvara se sučelje za modeliranje sklopa i predloženi prozorčić za dodavanje komponenti 

(engl. Add Component) (Slika 5.32).  

 

Slika 5.32 Sučelje za modeliranje sklopova - Assembly 
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Dodavanje se dijela ili podsklopa vrši se naredbom Open u prozoru Add Component, gdje se 

pojavljuje prozor za pretraživanje komponenti -Part Name (Slika 5.33). Dovoljno je upisati broj 

(ime) komponente ili pronaći mapu u koju je spremljena komponenta te odabrati komponentu i 

pritisnuti dugme OK za nastavak sklapanja. Naredbu se za dodavanje ostalih komponenti u sklop 

Add Component može pozvati preko izbornika Assemblies ► Components ► Add Component. 

 

 

Slika 5.33 Prozor za umetanje komponente u sklop - Part Name 

 

Komponente se mogu dodati i iz baze podataka, kao već gotovi modelirani dijelovi sa 

pripadajućim tehničkim crtežima. U fazi su izrade modela gibljive grede u tvrtci Same Deutz Fahr 

korišteni i gotovi modeli poput posteljice za klizni ležaj, rascjepke, kuglični ležaj, podloške, 

elastične podloške i vijci. Svaki dio sadrži svoj početni broj kojem se priključuju brojevi iz tablica 

koji definiraju dimenzije proizvoda.  

Konkretan je primjer dodavanje standardnog vijka M12x1,75x35 iz baze podataka u vijčani 

sklop gibljive grede.  

Njegov početni broj 2. prikazuje da standardni dio 0112 označava broj grupe vijka sa šesterokutnom 

glavom i djelomično narezanim navojem. Sve su dimenzije definirane po normi UNI EN ISO 4014.  

Broj 4. označava standardnu veličinu narezanog navoja M12, a duljinu vijka od 35 mm zamjenjuje 

broj 13 iz tablice 5.2. Posljednji broj .2 označava završnu obradu (pocinčavanje i sl.).  

Vijku je definirano ime 2.0112.413.2 po kojem se identificira i ubacuje u vijčani sklop gibljive 

grede. 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

48 

 

 

Tablica 5.1 Tablica standardnih dimenzija vijka 
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Tablica 5.2 Tablica standardnih dimenzija vijka (nastavak) 
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 U nastavku se pojavljuje dijaloški prozor za određivanje geometrijskih ograničenja sklopa 

(engl. Assembly Constraints) (Slika 5.34).  Geometrijska ograničenja možemo pozvati na alatnoj 

traci Assemblys ili preko izbornika Assemblies ► Component Position ► Assembly Constraints.  

 Za prvu je ubačenu komponentu ili neki podsklop potrebno zadati ograničenje Fix 

(pričvrstiti), jer se od tog učvršćenog elementa mjere ostala geometrijska ograničenja novih 

komponenti koje se dodaju i zajedno čine jedan sklop. Najčešći je tip ograničenja koji se koristi za 

zbližavanje dva objekta Touch Align (Dodirni-Poravnaj). Ovdje se mogu odabrati orijentacije 

ograničenja (Orientation) Touch, Align i infer Center / Axis. 

 

 

Slika 5.34 Prozor za ograničavanje komponenti u sklopu - Assembly Constraints 

 

 Za zavareni se podsklop gibljive grede sklapaju limene oplate, rukavci, čahura za klizni ležaj 

i skidač. Na Slika 5.35 prikazana djelomično sklopljena gibljiva greda s unesenim ograničenjima 

(Touch Align ► Infer Center / Axis) za poravnanje oplata, rukavaca i čahure, dok su za skidač 

postavljena ograničenja Distance i Parallel. Za završetak je sklapanja podsklopa potrebno pozvati 

ograničenje dodirivanja među elementima (Touch Align ► Toch). Kada je dobiven sklop sa svim 

unesenim geometrijskim ograničenjima, potrebno je izvesti operaciju zavarivanja (engl. Welding) za 

ovu vrstu podsklopa.  
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Slika 5.35 Dodavanje elemenata u sklop i geometrijska ograničenja 

 

 Zavarivanje na modelu nalikuje zavarivanju i u proizvodnji. Pri zavarivanju su gibljive grede 

korištene dvije vrste zavara, kutno i čeono. Alat se za prikazivanje zavara na modelu odabire po tipu 

zavara, primjerice za izvedbu se kutnog zavara pozove naredba Fillet preko izbornika Insert ► 

Welding ► Fillet. U dijaloškom se prozoru Fillet Weld odabiru površine koje se spajaju 

zavarivanjem: rub, visina presjeka zavara i parametri zavarivanja (Slika 5.36). 

 

 

Slika 5.36 Primjer kutnog zavara na gibljivoj gredi 
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 Nakon ubacivanja dijelova, ograničavanja i zavarivanja komponenti u zavarivačkom se 

podsklopu otvara se nova datoteka Assembly za sklapanje vijčanog podsklopa. Vijčani podsklop se 

sastoji od zavarivačkog podsklopa, glavčina, ležajeva, podloški, vijaka i ostalih elemenata koji čine 

sklop. Da bi se dobio vijčani podsklop primjenjuju se ista geometrijska ograničenja između modela 

kao i u sklapanju zavarivačkog podsklopa (Slika 5.37). 

 

 

Slika 5.37 Gibljiva greda 

 

5.3. Izrada tehničkih crteža 

Tehnička je dokumentacija osnovno sredstvo tehničkog načina izražavanja i komuniciranja. 

Tehnička dokumentacija prati faze izgradnje industrijskog postrojenja ili uređaja pa se kroz nju vidi 

i pristup izgradnje postrojenja i uređaja [9]. 

Tehnički je crtež jednoznačna i potpuna informacija o nekom proizvodu. Na tehničkim su 

crtežima proizvodi prikazani sukladno određenim pravilima, odnosno, normama važećim za 

tehničko crtanje. Izvedbeni crtež prikazuje strojni dio (nerastavljiv) sa svim potrebnim podacima za 

njegovu izradu [9]. 

Izrada je tehničke dokumentacije programom Siemens NX  jednostavna zbog povezanosti 3D 

modela s dokumentacijom. Izmjene se na prostornom modelu automatski odražavaju (generiraju) na 

dokumentaciju. 

Primjer će izrade tehničkog crteža biti prikazan na modelu Rukavac. 
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Za izradu je crteža u Siemens NX potrebno kreirati novu datoteku (_t1.prt) na osnovnom 

sučelju programa, slično kao i kod kreiranja nove datoteke za izradu modela kod ostalih modula. 

Potrebno je odabrati Drawing karticu i u predlošcima izabrati format crteža. Otvoreno je sučelje sa 

pripremljenom tablicom i okvirom koji su skriptirani u  NX-u na razini tvornice Same Deutz Fahr 

(Slika 5.38).  

Siemens NX iz modela predmeta automatski izrađuje poglede koji će se projicirat na tehnički 

crtež: pravokutni pogled (tlocrt, nacrt i bokocrt), prostorni (3D), poglede presjeka te detaljne i 

pomoćne poglede. Na pravokutne se poglede postavljaju kote, znakovi obrade, pozicije i dr. 

 

 

Slika 5.38 Sučelje za izradu tehničkih crteža 

 

Postavljanje se osnovnih pogleda na sučelje određuje preko prozora Base view (osnovni 

pogled) koji se automatski pojavljuje nakon kreiranja sučelja za izradu crteža. U prozoru se Base 

View određuje odgovarajući položaj modela u pogledu, mjerilo i dr. Povlačenjem se miša prema 

sučelju pojavljuje gledište modela predmeta, a klikom se miša određuje se položaj prve projekcije.  

Za nastavak je projiciranja dovoljno povlačenje miša van prvog gledišta i pojavljuje se novo gledište  

i prozor Projected View za uređenje novog gledišta (Slika 5.39). 
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Slika 5.39 Bazni pogled i njegova pravokutna projekcija 

 

Nakon postavljanja osnovnih pogleda, pristupa se postupku kotiranja projekcija na crtežu. 

Postavljanje numeričkih vrijednosti, simbola, znakova, simetrala, dimenzija i sl. na tehnički crtež, 

može se nazvati kotiranjem.  

Sve izmjere moraju biti unesene tako da se upotpunjuju s definiranim oblikom strojnog 

dijela, da se u proizvodnom procesu lako razumiju te da isključuje svaku dvojbu, zabunu i 

mogućnost pogrešaka. 

Dimenzija ili izmjera je numerička vrijednost izražena u naravnoj jedinici mjerenja (u 

strojarstvu je to milimetar, mm) i označena je grafički na tehničkom crtežu [9]. 

Izrada dimenzija na tehničkom crtežu počinje odabirom jedne od naredbi na alatnoj traci 

Dimension. Na alatnoj se traci nalaze naredbe za različito nanošenje dimenzija. Najčešće je 

korištena Inferred Dimension (za postavljanje dužinskih izmjera, promjera, kutova i sl). Na alatnoj 

se traci Annotation nalaze naredbe za postavljanje znakova, primjerice znakovi završne obrade, 

brojevi pozicija i simetrale (Slika 5.40).  

Nakon odabira željene naredbe, potrebno je odrediti liniju ili rastojanje kojima je potrebno 

dati pripadajuću dimenziju klikom miša i povlačenjem u smjeru u kojem se želi pozicionirati 

dimenzija. Istim se postupkom unose znakovi završne obrade,  simetrale, oznake zavara i drugo. 

Također, na isti način se izrađuju i tehnički crteži za sklopove.  
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Na Slika 5.41 prikazan konačan izgled tehničkog crteža dijela Osovina. U nastavku su 

prikazani redom tehnički crteži dijelova koji čine zavarivačke pod-sklopove lijeve i desne gibljive 

grede. U nizu su prikazani crteži sastavnih dijelova vijčanog pod-sklopa.  

Dijelovi: Čahura (Slika 5.42), Limena oplata (Slika 5.43), Rukavac (Slika 5.44) čine lijevi 

zavarivački pod-sklop (Slika 5.45). Graničnik (Slika 5.46) je dio koji se dodatno zavaruje na pod-

sklop identičan lijevome i time zajedno čine desni zavarivački pod-sklop (Slika 5.47), koji zajedno 

sa dijelovima: Podloška (Slika 5.48), Prsten (Slika 5.49), Ležaj (Slika 5.50), Glavčina (Slika 5.51) 

čine vijčani pod-sklop desne gibljive grede (Slika 5.52). Na kraju je prikazan realističan prikaz 

vijčanog pod-sklopa Gibljiva greda (Slika 5.53) 

 

 

Slika 5.40 Naredbe za postavljanje kota - Inferred Dimension 
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Slika 5.41 Tehnički crtež dijela Osovina 

 

 

Slika 5.42 Tehnički crtež dijela Čahura 
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Slika 5.43 Tehnički crtež limene oplate gibljive grede 

 

 

Slika 5.44 Tehnički crtež dijela Rukavac 
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Slika 5.45 Tehnički crtež zavarenog pod-sklopa lijeve gibljive grede 

 

 

Slika 5.46 Tehnički crtež dijela Graničnik 
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Slika 5.47 Tehnički crtež pod-sklopa desne gibljive grede 

 

 

Slika 5.48 Tehnički crtež dijela Podloška 
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Slika 5.49 Tehnički crtež dijela Prsten 

 

 

Slika 5.50 Tehnički crtež dijela Ležaj Ø18x80x40 
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Slika 5.51 Tehnički crtež dijela Glavčina 

 

 

Slika 5.52 Tehnički crtež vijčanog pod sklopa gibljive grede 

 

 



Diplomski rad                                                                                                              Josip Živković 

 

_____________________________________________________________________________ 

62 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Slika 5.53 Gibljiva greda u realnom prikazu  
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6. ANALIZA I DISKUSIJA POSTUPKA 

  U praktičnom su dijelu rada, opisanom u petom poglavlju, prikazane neke od osnovnih 

metoda kreiranja modela u programu Siemens NX, koje su dovoljne za izgradnju modela gibljive 

grede. Prikazane su osnovne metode modeliranja, dobivanja sklopa, zavarivanja i izrade tehničke 

dokumentacije. 

 

Za kreiranje modela vijčanog pod-sklopa korišteni su standardni elementi iz baze podataka 

koji znatno štede vrijeme i troškove izrade, naročito kod većih sklopova. U radu su prikazana samo 

neka geometrijska ograničenja koja se koriste za izradu modela sklopa. Za  potpuno sklapanje u 

konačan sklop, potrebno je uključiti dodatna ograničenja kao što je dodir ili poravnanje (Touch, 

Align) linija, površina ili točaka. Kod postupka zavarivanja, primjerom je prikazan postupak izrade 

kutnog zavarivanja, kod spoja limenih oplata korišten je postupak čeonog zavarivanja koji je, 

također, lako izvediv uz dodatne postavke koje je potrebno ispuniti. 

 

Kod izrade tehničkih crteža, potrebno je ispuniti osnovnu tablicu podacima potrebnim za 

proizvodnju, kao što su materijal dijela, boja, tko je crtao, pregledao i odobrio crtež.  Program 

automatski ispisuje ime i broj dijela koji su definirani pri samom početku kreiranja modela dijela od 

kojeg nastaju pravokutni pogledi (tlocr, nacrt, bokocrt i dr.) na tehničkom crtežu. 

 

Program Siemens NX omogućuje jednostavnu izradu modela i tehničke dokumentacije u 

svojim modulima. U radu su iznijeta osobna iskustva početnika u korištenju programa Siemens NX, 

a u ovom se dijelu namjerava izraziti i zadovoljstvo radom u programu. Možda se u početku rad u 

programu čini složenim, ali ponavljanjem operacija i daljnjim učenjem on postaje jednostavniji i 

brži u modulima koji se koriste za izradu gibljive grede. Program nije znatno usporavao rad računala 

prilikom izrade modela. Siemens NX, složeni CAD/CAM/CAE sustav koji obuhvaća veliki spektar 

poslova te time otvara prostor za napredovanje i daljnji rad. 
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7. ZAKLJUČAK 

U radu je prikazan postupak izrade digitalne dokumentacije gibljive grede transportnih kolica 

u sustavu Siemens PLM NX. Opisan je povijesni razvoj i primjena gibljive grede te je, u praktičnom 

dijelu rada, detaljno opisan postupak izrade 3D modela dijela do konačnog sklopa i izrada tehničkog 

crteža. Kroz primjere je opisan razvoj modela i prikazane su osnovne funkcije i mogućnosti koje se 

koriste pri radu u progaramu  Siemens PLM NX.  

Siemens PLM NX je nova generacija integriranog programskog sustava za digitalno 

projektiranje i proizvodnju s velikim izborom modula koji u zajedničkoj okolini omogućuju 

obavljanje pojedinih zadataka koji teže zajedničkom cilju; u što kraćem vremenu i što jefitinije 

ponuditi proizvod zahtjevane kvalitete.  

Vrijedi istaknuti neke od mogućnosti programa koje su korištene pri izradi modela gibljive 

grede i dovele do zaključka:  

 Spremanje datoteka na server pri čemu se uvodi red među datotekama, pregled nad 

svim predhodnim verzijama datoteke i lakše pronalaženje u slučaju ponovnog 

korištenja.  

 Laka izmjena modela i crteža; automatski se generira isti predmet ako je korišten u 

nekom sklopu i njegov tehnički crtež što znatno ubrzava izradu digitalne 

dokumentacije jer nije potrebna ponovna izrada modela i crteža zbog izmjene. 

 Ubacivanje standardnih gotovih elemenata u sklop znatno ubrzava vrijeme izrade. 

 Siemens NX se zasniva na inženjerskoj logici pa je dojmljivo zavarivanje i sklapanje 

sklopa koje priliči kao i u proizvodnji. 

 Program brzo i točno izračuna razvijeni oblik limenih modela koji se koristi kao 

šablona za izrezivanje lima laserom u proizvodnji. 

Sustav je namijenjen velikim tvornicama kao npr. Same Deutz Fahr koja za svoje potrebe 

koristi Siemens NX u punoj snazi i može si priuštiti tako skup program koji će odgovoriti na sve 

potrebe tvornice i ispuniti očekivanja. Cijena licnece programa u odnosu na dobit koju ostvaruje 

tvornica kombajna Same Deutz Fahr je zanemariva. Primjerice, cijena kombajna na tržištu iznosi od 

180 000 – 250 000 € dok je cijena programa Siemens NX oko 14 000 €. U cijenu programa je 

uključena podrška dobavljača u svakom trenutku koja je značajna zbog same ispravnosti korištenja 

programa. 
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PRILOZI 

PRILOG I: Kompaktni disk s PDF datotekom rada i s radnim datotekama Siemens NX 

modela i tehničkih crteža. 

 

Broj stranica: 1 
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